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Control4 Disclaimer

Control4® makes no representations or warranties with respect to this publication, and specifically disclaims any express or
implied warranties of merchantability or fithess for any particular purpose. Control4 reserves the right to make changes to any
and all parts of this publication at any time, without any obligation to notify any person or entity of such changes.

Trademarks

Control4 and the Control4 logo are registered trademarks of Control4 Corporation. Other product and company names
mentioned in this document may be the trademarks or registered trademarks of their respective owners.

Legal Notice

GNU

GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
(Section 3.b.)

You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the
terms of Sections 1 and 2 above provided that you also do one of the following:

Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of
physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 on a medium customarily used for software interchange.

The complete text for this license is available on the Control4 web site at: http://www.control4.com.
Gracenote

Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either a registered trademark or a
trademark of Gracenote, Inc. in the United States and/or other countries.

Music and DVD recognition technology and related data are provided by Gracenote®.

Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. For more information
visit www.gracenote.com.

MPEG

Fraunhofer 1IS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IS and Thomson. Supply of
this product does not convey a license nor imply any right to distribute content created with this product in revenue-generating
broadcast systems (terrestrial, satellite, cable, and /or other distribution channels), streaming applications (via Internet,
intranets, and/or other networks), other content distribution systems (pay-audio or audio-on-demand applications, and the like)
or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards, and the like). An
independent license for such use is required. For details, visit http://mp3licensing.com. Radio Locator is the service provider of
AM/FM channel list.

© 2005-2008 All Media Guide, LLC provides music and video recognition technology that provides cover art and related text
that enriches the Control4 user Navigators.

Copyright

© 2010 Control4. All rights reserved. Control4, Control4 logo and Everyday Easy are registered trademarks or trademarks of
Control4 Corporation in the United States and/or other countries. All other brands or names may be claimed as property by their
respective owners. Pricing and specifications subject to change without notice.

No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express
written consent of the publisher.
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Introduction

Use the Control4® Composer Media Edition (ME) application to set up your media and playlists and
perform other tasks related to your music, movies, and videos.

Purpose

The purpose of this document is to give you instructions, examples, and tips about how to add and
manage the media for your Control4 system.

Related Documents and Resources

Document file name Title and location

Control4 System PDF:
Getting Started

Control4 System User PDF:
Guide

What's New in This Release?

The Control4® Composer ME software and hardware updates are detailed below.

Note: This document has not been updated since Release 1.6.0.

Highlights:
¢ New Navigator interface
e Improved media management and performance
e ZigBee Pro implementation for the broader market
o New or updated documentation for homeowners

New Media and Hardware Support

e A new Flash interface has replaced the interface in Release 1.8.x and earlier. This interface
appears on all of the graphical Navigators (Touch Screens and On-Screen Navigators). The
Control4 System User Guide and Control4 System Quick Start Guide for OS 2.0 explain how
to use this new interface.

¢ A new Control4 4Store™ has been added to the Navigators. Customers can purchase
applications for the Touch Screens and On-Screen Navigators in their Control4 system.

e Media menu. New option 'Tag media files.'
e A new IO Extender has been added to the Control4 product line.
e A new Media Player has been added to the Control4 product line.

Copyright © 2010 Control4. All Rights Reserved.
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A new Home Controller HC-1000 V3 has been added to the product line.
Support for AAC and WMA music formats.
New robust media online lookup service that replaces AMG.

1.3.2 New or Updated Topics

The Composer and Composer-related documents have been updated and restructured for
Control4 OS 2.0 to make it easier for you to get the information you need more quickly. Most
topics in this document are available in online help (application), WebHelp, or PDF on the
Control4 web site.

All topics have been restructured, reordered, and enhanced.

e New links, bread crumbs and Glossary pop-ups have been added to the topics in the
online help.

e Text has been pared down for ease of use and readability.

1.3.3 Hardware and Software No Longer Supported or Partially
Supported

Home Theater Controller (not as a Primary Controller; new Ul not supported in OS 2.0)
Media Controller (not as a Primary Controller; new Ul not supported in OS 2.0)

Home Controller HC-1000 V1

Home Controller HC-500

10" Wall Mount Touch Screen (new Ul not supported in OS 2.0 and will not be updated)
10.5" Wireless Touch Screen V1 (new Ul not supported in OS 2.0 and will not be updated)
Mini Touch Screen V1 and V2 (new Ul not supported in OS 2.0 and will not be updated)

System Remote Control V1 and V2 (these remotes will need to be replaced if used with OS
2.0)

Contact Relay Extender (does not support ZigBee Pro). Use an IP connection for OS 2.0.
Audio products (do not support ZigBee Pro). Use an IP connection for OS 2.0.

Easy Setup

Easy Importer

Pool Controller. The Ul for pool control is not completed in OS 2.0, although the drivers and
proxies remain in place in Composer. If this is important, leave at least one of the older
navigators for this purpose.

The AMG lookup service has been changed to Gracenote®. The Sony 777 Disc Changer
uses Gracenote, but the Media Controller can no longer access album, title, or artist
information from AMG. CDs, however, can be imported and will show up in the Media
database with a date and time stamp.

Other Media Managers: You can use other media managers, for example, iTunes, Windows
Media player, and Media Monkey to create MP3s. You can still use Composer ME and
Composer HE to add files to Control4.

1.3.4 Hardware that Doesn’t Support ZigBee Pro

Control4 System Remote Control, V1 and V2

Copyright © 2010 Control4. All Rights Reserved.
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e Audio products: Amps, Switches, Tuners, Speaker Point, etc. Use an IP connection for OS
2.0.

e Card Access Products: Contact and motion sensors, remote.
e Contact Relay Extender. Use an IP connection for OS 2.0.

Getting Started

Control4® Composer Media Edition (Composer ME) is the software you use to add, scan media, edit
media information, and create playlists on the Control4 system for use with the Control4 Navigators.
Using a Windows XP-based PC, this program uses a drag-and-drop interface and runs on the
Control4 Operating System (OS) Release 2.0.

The brains of the Control4 system is the Control4 Controller (Home Controller HC-200, HC-300, or
HC-1000 V3). The Controller communicates with Control4 and third-party products to enable home
automation and interaction of Control4-controlled devices.

Note: When the term 'Controller' is referenced in this document, it refers to any Control4 product that
contains the Director component, such as Home Controller HC-1000 V3.

2.1 Requirements
Control4® Composer ME requires that your system is functioning correctly before attempting to use
the software (OS 2.0 and later). Talk to your Control4 Dealer if this product does not function as
documented; this may indicate that the Conrol4 system is not set up properly.
Software and network requirements for using Composer ME:
e Control4 Controller (such as Home Controller HC-1000 V3, which has a 500 GB storage
capacity). Note: The Media Controller and Home Theater Controller are not supported in OS
2.0 as Primary Controllers (Secondary Controllers only).
e PC to run the Composer ME software and control the devices.
e Composer Media Edition (launches Microsoft .NET 1.1 web install).
e Microsoft Windows XP and Service Pack 3 (Home or Professional), Windows Vista, or
Windows 7.
e 500 Mhz processor or higher.
e 256 MB RAM.
e 80 MB hard disk space.
e Video card and monitor supporting resolution of 1024 x 768 or higher.
e Keyboard.
e Mouse.
e TCP/IP-based home network (DSL/cable modem, Control4 secure gateway, router, or switch)
to connect the PC to the Controller.
¢ Internet Connection (broadband required for retrieving cover art and media information).
e Registration at my.control4.com is required. See your Control4 Dealer or the Control4 System
Quick Start Guide (available on the Control4 web site) for details.
Copyright © 2010 Control4. All Rights Reserved.
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2.2 Installing Composer ME
Follow the steps below to install the Control4® Composer ME software.
2.2.1 Prerequisites
Ensure that you understand the software and network requirements to use this product. Your Control4
Dealer or Installer can assist you if needed.
2.2.2 Procedure
To install Composer ME:
1. Start the Composer Media Edition installation and follow the on-screen instructions. You might be
asked for a registration key. If so, check with your Control4 Installer or Dealer for details.
2. If prompted to update, follow the on-screen instructions to update to the latest version of
Composer ME.
The Composer ME software and device drivers may have been updated when the CD or Web
download was created. Control4 recommends, however, that you always choose to update.
2.3 Starting Composer ME
When you start Control4® Composer ME, you must connect to Director on your home network.
2.3.1 Prerequisites
Ensure that you have installed Composer ME and registered on my.control4.com. You may want to
use Rhapsody® also (a subscription-based music service).
2.3.2 Procedure
To start Composer ME:
1. From the desktop, double-click the Composer ME icon.
2. Atthe Composer ME startup screen, click Director on Local Network.
Copyright © 2010 Control4. All Rights Reserved.
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Composer
Connect fo:
v :.—...: G
Virtual Direcior Director on Remole Director

Local Nebwork

s Control(®

Note: Even though the Virtual Director and Remote Director show on the Startup screen, they are not
available in Composer ME and are grayed out.

3. From the Directors dialog, select the Director’s address of the Controller you are setting up.

L Directors

Mame Address Connect

cd:controld director-mc36-E.ath 10.0.0.3

Add...

| Refresh |

Tip: If the Director’s address does not appear immediately, click the Refresh button. If it still does not
appear, contact your Control4 Dealer.

4. Click Connect.
5. Composer opens to the main Composer ME interface.

Copyright © 2010 Control4. All Rights Reserved.
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Refreshing the Navigators

Use the Control4® Composer ME Menu to refresh your Touch Screens, On-Screen Navigators, and
System Remote Control whenever you make changes to Composer.

Prerequisites

Ensure that the Navigators are added and identified to the Control4 system. Your Control4 Dealer or
Installer can help you do that.

Procedure
To refresh the Navigators:

In case your Navigators do not automatically refresh after you've made changes to Composer ME,
from the menu bar, choose File > Refresh Navigators.

Tip: New media shows up automatically in the Navigators unless your device is disconnected or has
changed locations. In this case, you may need to identify the device again.

Refer to the Control4 System User Guide to test normal Navigator features.

Closing Composer ME

Use the Control4® Composer ME File > Exit or Exit Composer options to close the application.

Before Composer ME exits, the application asks you if you want to back up your project. It is always
good practice to do so.

Saved: 5/18/2010 3:54:00 PM
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Introducing Composer ME

The Control4® Composer ME interface lets you:

e Add and scan media to your Controller (for example, Home Controller HC-200, HC-300, or

HC-1000 V3).

e Create playlists of MP3, AAC, FLAC, or WMA files saved on your Controller’s hard drive in

the Media Database (requires a HC-1000 Controller).

Prerequisites

Ensure that Composer ME has been installed.

Procedure

To use Composer ME:
1. Start Composer ME.

2. Connect to the Director on Local Network. (See “Director's Dialog” below.)

3. View the Media pane (see below).

The Composer ME interface:

Dptions

Media Seanning

A (0300 5

Fles To Scan
Dievices Exersions
[£] Mtk Fie Shixagn M judc] -~ A
Ly
[2] CBM Plaeh Disk FLAE {fnsdol

[2] Usm Cirkinn Macka Lok o impcren scan et
[7] Riminivm s i the clatibuncn # hon s 123 korages st
[7] Uppdate rreecha chatistase i fie Lxgs v changed

SeanMow | [ S Sean

Daector Status |de

When you add or scan media (Media Scanning Options), you can then view and select the stored/
broadcast media and playlists from the Touch Screens or On-Screen Navigators: TV monitor, Touch

Screens, and System Remote Control (in List format).

Saved: 5/18/2010 3:54:00 PM
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3.3 Director’s Dialog

After you start the Control4® Composer ME application, the following dialog appears; you need to use
the Controller's network address to connect to the Director.

G Directors ]g]

Marmne Address Connect

cd:contrald_directorme3B-Fath. | 10.0.0.3

Cancel

ik

Add...

Refresh

Connecting to a Director on the home network lets you set up your media cover art and metadata on
your Controller so it is viewable on the Touch Screens or On-Screen Navigators. Each Director has an
associated address.

Director's Dialog buttons:
e Connect. Connect to the Director that is on the Controller.
e Cancel. Cancel and close the Director dialog.

e Add. Launch a dialog that lets you add the Director’s address of the Controller to which you
are trying to connect.

o Refresh. Update the Director list to display the recently added Directors.

3.4 Media View

Use the Control4® Composer ME Media view to add or scan your media.

Media view (same view as the main screen after startup):

Copyright © 2010 Control4. All Rights Reserved.
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There are two (2) types of media that can be added or scanned in a Control4 system:
1. Stored Media
2. Broadcast Media

Note: The AMG lookup service has been switched to Gracenote®. The Sony 777 Disc Changer uses
Gracenote, but the Media Controller can no longer access album, title, or artist information from AMG.
CDs, however, can be imported and will show up in the Media database with a date and time stamp.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media
player, and Media Monkey to create MP3s. You can still use Composer ME and Composer HE to add
files to Control4.

3.4.1 Stored Media
Media types supported:

e CD. Store CD selections by viewing Cover Art, Album, Artist, and Genre type (such as Rock
or Country).

e DVD or Disc Changer. Store DVD and CD selections by viewing Cover Art, Title, Info,
Results, Media, and Disc List.

e Digital Audio Player. Store MP3, HDD, AAC, FLAC, or WMA music selections by viewing
Cover Art, Album, Artist, and Genre type (such as Rock or Country) on a Home Controller
HC-1000 V3 hard disk or other digital audio player.

o Network File Storage. Store MP3, HDD, AAC, FLAC, or WMA music selections by viewing
Cover Art, Album, Artist, and Genre type (such as Rock or Country) on a hard disk attached
to the network or a USB Flash Disk.

3.4.2 Broadcast Media

Copyright © 2010 Control4. All Rights Reserved.
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Media types supported:
e Direct TV. View Direct TV channel options including Station ID, Genre, and Music Channel.

e Dish Network. View Dish Network channel options including Station ID, Genre, Rating, and
Music Channel.

e Cable TV. View Cable channel options, including Station ID, Genre, Rating, Music Channel.
e UHF/VHF. View the UHF channel options including Station ID, Genre, Rating, HDTV.
o  AM/FM/XM. Scan AM, FM, and XM stations.

3.5 Menu Options
Use the Control4® Composer ME menu options are;

e File menu. Connect to the Director on your home network, refresh Navigator devices with
new media information, or exit Composer ME.

e Media menu. Create a new playlist, or clear, export, and import media lists. See 'Media
Menu' below.

e Help menu. View the online help and software version.

3.5.1 File

The File menu lets you perform project file management tasks, connect to the Director, start
Interviewer, and refresh Composer and the Navigators, including the Touch Screen and On-Screen
Navigators. The file management options relate to the Composer HE project files you back up on your
PC (they have a .c4p extension). Project files always save by default to the 'My Documents' directory.

When you set up a Control4 system, you create live project configuration information on the Controller
that is backed up to a project file on your PC also. This lists specific information about each system,
including devices, connections, configuration, programming information, and media.

e Connect to Director. Connects you to the Director residing on the Controller. When you
connect, project configuration information from the Controller is displayed on the Composer
ME screen.

e Disconnect from Director. Disconnects you from the Director. Composer ME prompts you
to back up your project before disconnecting you from the currently-connected Director. This
option is available when connected to the Director.

o Refresh. Refreshes the Composer ME screen with the current information from Director.
o Refresh Navigators. Refreshes the Navigators with the latest information from Director.

e Exit. Exits Composer. Composer ME prompts you to back up your project prior to exiting the
software and returning to the desktop.

Copyright © 2010 Control4. All Rights Reserved.
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3.5.2 Media

The media either has been scanned or manually added into the Media Database. After an item is
added to the Media Database, the cover art and metadata about the media is viewable and selectable
from any of the Navigators.

Tip: Control4 recommends that you use the Export Media List feature which lists of all your media
saved to the hard drive on your PC.

The following options are available:

3.5.3 Help

Clear Media List. Clears the media list associated with the highlighted device from the Media
Database.

Export Media List. Exports a media list for the selected device from the Controller to your
PC.

Import Media List. Imports a media list from the PC to the Controller.

Export Playlists. Exports a playlist from a Controller to a PC.

Import Playlists. Imports a playlist from the PC to a Controller.

Import DVD List from File. Imports an Excel list of DVD titles for a Disc Changer.

New Playlist. Creates a playlist of MP3, AAC, FLAC, or WMA files. The playlist is available
from any Touch Screen or On-Screen Navigator. Add albums, remove songs, re-order songs,
etc. Note: If you remove songs from a playlist, it does not remove them from the Media
Database.

Delete Playlist. Removes a playlist.
Rename Playlist. Renames a playlist.

Tag media files. Used for OS 2.0 conversion of media files so all media players can see the
same tags.

From the Help menu, you can access the online help of this User Guide with Index, Glossary, and
Search options, or check the version of your Composer software and Director component.

Copyright © 2010 Control4. All Rights Reserved.
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4.  Setting Up Media and Playlists

To view and select your media from the Control4®Navigators, the Control4 system needs to be able to
recognize it. So you first need to add and scan your media to the Controller using the Composer ME
Media view. See “Auto-scan Media in Composer ME” in this document.
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To add and scan songs and albums for playlists, they must be available in MP3, M4A/AAC, or FLAC
format on a PC, Controller, or network share. With the MP3, M4A/AAC, WMA, or FLAC files you add
and scan, you can create playlists and save them either to the Controller’'s hard drive or a network
storage drive.

Tip: This product requires that your system is functioning correctly before using Composer ME. For
example, if a Disc Changer does not appear in the left pane of the Media view, there's no Disc
Changer in the system to add media to it. Contact your Control4 Dealer if this is the case.

4.1 Prerequisites

Ensure that the appropriate devices have been added and identified to the Control4 system. Your
Control4 Dealer or Installer can do this for you.

Copyright © 2010 Control4. All Rights Reserved.
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4.2 Procedure

To add and scan available Digital Audio Player media:

1. Start Composer ME and connect to Director.

2. Inthe Controller pane, click Add.
Tip: If you get a dialog box that states you cannot add media, make sure your Control4 Installer
or Dealer has identified your Controller for you.

3. Browse to the directory of music files that you want to add or scan.
After the files have been added, the scan automatically starts. In a few moments, the media is
scanned and you will see a list of albums appear. You might see the On-Screen Navigator update
during this process also.
Tip: Another way to add files from a network share to a Controller is to go to the Windows Start
menu, and select Run. Type //[<Controller's IP
Address>/media/audio/music/<Artists>/<Albums> and copy the files there.

4. Refresh your Navigators.

5. The media is now selectable for viewing from the Touch Screens, and On-Screen Navigators, and
System Remote Control.

4.3 Setting Up Media on a CD or Disc Changer

When setting up a Control4®Disc Changer (or CD Changer), you can add and scan media according

to the controls available on your Disc Changer. Adding and scanning populates the media information

to the Media Database, which lets you view the media from your Touch Screens, On-Screen

Navigators, and System Remote Control.

Notes:

The AMG c4lookup service from previous releases has been changed to Gracenote® and Control4

has not implemented a Ul for browsing CDs stored in a Disc Changer in OS 2.0. Use an older

navigator (prior to OS 2.0) that supports this functionality if this is important.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media

player, and Media Monkey to create MP3s. You can still use Composer ME and Composer HE to add

files to Control4.

Copyright © 2010 Control4. All Rights Reserved.
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In the Media pane, if you select CD or Disc Changer, the following options are available. In some
cases, you select an entry and click a button, or just click one of these buttons (Search and Scan):

e Edit. Edit an entry's metadata (title, artist, director, genre, etc.).
e New DVD. Add new DVDs to the Media Database.

e New CD. Add new CDs to the Media Database.

o Delete. Delete an existing entry.

e Scan. Scan the media on your CD or Disc Changer to the Media Database (recommended if

available).

e Search. Search for media titles on your CD or Disc Changer in the Media Database.

THE SONY 777 DisC CHANGER USES GRACENOTE, BUT THE MEDIA CONTROLLER CAN NO LONGER ACCESS ALBUM, TITLE, OR ARTIST INFORMATION FROM AMG (THE PREVIOUS LOOKUP SERVICE). CDS, HOWEVER, CAN

BE IMPORTED AND WILL SHOW UP IN THE MEDIA DATABASE WITH A DATE AND TIME STAMP.
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The following steps show how to add media to the Media Database using these options.

Prerequisites

Ensure that the CD or Disc Changer has been added and identified in the Control4 system. Your

Control4 Dealer or Installer can do this for you.
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4.3.2 Procedures
To scan media on a CD Changer to the Media Database:
1. Selectthe CD Changer in the Media pane.
2. Inthe Disc Changer pane (right pane), click Scan.

3. The scan results appear in the Discs pane. After you refresh the Navigators, you are ready to play
music.

To search media on a Disc Changer to add to the Media Database:
1. Inthe Disc Changer pane, click Search. The search dialog appears.

2. Type the DVD name into the blank box. For example, 'A Beautiful Mind," and then click Search.
The 'DVD Title' matches appear in the Search Results window.

3. Use the scrollbar if necessary to find the appropriate DVD title.

4. Select the DVD title, drag it directly over the empty line item in the Disc Changer list, and then
select it.

5. Click Finished.

6. Repeat the previous steps for the DVDs/CDs in the Disc Changer that you want to add to the
Media Database.

7. Refresh the Navigators. The media you added is now available to view in the Navigators.

To add and search using the New DVD or New CD options:

1. Select CD or Disc Changer in the Media pane.

2. Select an 'empty' line item for the New DVD and New CD buttons to appear.
3. Click either New DVD or New CD as appropriate.
4

The New Movie or New Album dialog appears. In the Title box, enter the DVD you want to play,
for example: 'A Beautiful Mind.'

5. Click Search.

New DVD:

Copyright © 2010 Control4. All Rights Reserved.
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New Movie
Movie | Cast and Synnpsisl
Title:
| | [ Search... ]
Director Run Time:
Studio: Released
Genre: Rating
Location:
[ |
At
Find Art File...
No Artwork ;
Available Faste From Clipboard

The following results appear:

Search

| |T|lls

Vl[ Search ]

Search Results

Title:

A Beautiful Mind [P45 Awards Edition] [2 Discs]

A Beautiful Mind [w'S Awards Edition] [2 Dizcs]

Autist

Getre

Drama

Drama

Drama

Drama

Drama

Drama

Drama

%

-

< Back

MNext >

Cancel

Select an entry to get detailed results:
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Search
itle [] Ant Cast
|A Breautiful Mind [P35 Awards Edition] [2 Discs] | Russell Crome; Jennifer Connelly; E Harrs; Paul
Bettany: Adam Goldbera: Judd Hirsch: Josh Lucas;
Director Anthany Fapp; Christopher Plummer; Austin Pendleton;
Jagon Gray-Stanford; Vivien Cardone
|Fh:|n Howard |
Studio:
|DreamWnrks |
Genre
|Drama |
Run Time: Released: Rating:
[128 | [20m | [Pa13
Synopsis

The true stom of prominent mathematician John Forbes Mash Jr. is the subject of this biographical drama from director Rion Howard, Russell
Crowe stars as the briliant but arogant and conceited professor Mash. The prof seems guaranteed a rosy future in the early '50s after he
marries beautiful student Alicia [Jernifer Connelly) and makes a remarkable advancement in the foundations of 'game theom." which carries
him to the brink of intermational acclaim. Soon after, John is visited by &gent \wWiliam Parcher [Ed Harri], from the ClA, who wants to recruit
him for code-breaking activities. But evidence sugagests that Mash's perceptions of reality are cloudy at best: he is struggling to maintain his
tenuous hold on sanity, and Alicia suspects a diagnosis of paranoid schizophrenia. Battling decades of ilness with the loyal Alicia by hiz side,
Mash iz ultimately able to gain some control over his mental state, and eventually goes o to tiumphantly win the Nobel Prize. Based loosely
on the book of the same name by Sylvia Nasar, & Beautiful Mind [2001] co-stars Paul Bettany, Adam Goldberg, Anthony Rapp, Christopher
Flummer, and Judd Hirsch. Karl Wiliams., All Movie Guide

[C] 2005 All Media Guide, LLC
Content provided by All Music Guide[R]. a trademark of 4ll Media Guide, LLC

< Back H Finished H Cancel

New CD:
Similar results appear as with New DVD. Follow the same steps.

Mew Album &

Alburm | Tracks | Motes
Hame:
| | [ Search...
Label: Year:
Genre:
Art
Find &t File.. |
Faste Fram Clipboard
[ Femove At ]
[ 1] ] [ Cancel
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6. When the Search dialog appears, use the scrollbar if necessary to find the appropriate cover art,
and highlight it.

You can change the search criteria, and search again if necessary. The possible matches from
the Web database appear in the Search Results window (see above).

7. Click Next. You can choose which information to import, and edit any associated information
before adding the media to the Media Database (see screen above).

8. Click Finished.
9. Inthe next screen, click OK.

10. Refresh the Navigators. The DVD is available to view in the CD or DVD pane and on the Touch
Screens and On-Screen Navigators.

Note: If no cover art is found in the file’s metadata, then no cover art is associated with the music
unless the system is registered in 4Sight, and you can go to the online media lookup (Media view >
Edit > Name > Search > Select > Next) to obtain the cover art for the music. Check with your Control4
Dealer or Installer for details.

Setting Up Videos for a Media Player

Your Control4® Dealer or Installer can help you get set up to play videos on your Control4 Media
Player. Your videos must already exist on a network-attached storage drive before they can be
scanned for the Media Player.

For information about scanning files for the Media Player, see the Control4 Media Player Installation
and Setup Guide or the Control4 Media Player User Guide.

Auto-Scan Media in Composer ME
This section applies to a Sony CX777ES Disc Changer.

The benefits of running a Control4® Disc Changer with bi-directional communications (RS-232), for
example, Sony CX777ES, is that you can scan your DVDs or CDs stored in the Disc Changer to
identify, index, and automatically apply cover art and media information. You can have your Control4
Dealer or Installer configure your Control4 system in Composer ME to scan media automatically, or
you can set a manual scan using the Scan button. The default is to scan media manually.

Copyright © 2010 Control4. All Rights Reserved.
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1. Ifyou scan a DVD or CD, and the media is not recognized, it will be titled “unknown.” You can edit
the DVD or CD's metadata and manually provide this information from either Composer ME or the
Navigators. If this DVD or CD is then changed to a different slot, the system will apply this same
information.

2. Because media scanning has been moved to the background, the scanning status is only
available through Director status messages. To do this, you can either watch the Director status
line or re-select the media to view the content that has been scanned.

3. Composer does not need to be open to scan media. This allows the user to use other media
managers (iTunes, Windows Media Player, etc.).

4.5.1 Prerequisites
Ensure that the devices you want to scan have been added and identified in the Control4 system.
Your Control4 Dealer or Installer can do this for you.
If you want to schedule regular scans, ensure that your network-attached storage is set up and is
accessible from Composer ME.
4.5.2 Procedure
To schedule a regular scan of media from a network-attached device for a Media Player, for example:
1. From the Composer ME main screen, select Media Scanning Options. To scan your media now,
click Scan Now and skip the Scanning Schedule in Step 2.
2. Inthe Options pane, set the schedule as follows:
e Scanning Schedule. Select one.

e Never. Select if you never want to schedule an automatic scan.

e Every x Days or Weeks (up to 10). Select the frequency to scan.

e Onthe following days. Select Sunday through Saturday.

e At <time>. Use the up and down arrows to select the time. Highlight AM or PM and type
the value: AM or PM.

e Files To Scan. Select a device and extension.

e Network File Storage. Select if you have a NAS you want to scan.

e USB Drive. The manufacturer's USB drive appears here. Select if you have a USB stick
you want to scan.

e Extensions. Use the up and down arrows to choose the file type to add or remove. To
add a file extension if it doesn't appear in the list, use the down arrow to select the
extension, select Video or Audio, and click Add. Click Remove to remove that file type
from the list.

e Use Online Media Lookup to improve scan results. Check if you don't want the search
to access the Internet for every format lookup, for example, a specific title or cover art.
Tip: Properly tagged files will result in must faster access.

Copyright © 2010 Control4. All Rights Reserved.
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e Remove media from the database if the files no longer exist. Check to remove
database information when a media file has been deleted. Be careful, however, because
if for example you disconnect a USB disk with media on it, the database files will delete
them if checked, and you may not want to delete them if you use the stick again.

e Update media database if file tags have changed. Check to have the database
updated if the metadata changes.

3. Click Apply.
4. Click Scan Now to start the scan immediately or Stop Scan if you've started the scan and want to
stop it.

4.6 Testing the Media Connection

To test control of media through the Control4® Navigators (System Remote Control, On-Screen
Navigator, LCD Navigator, or Touch Screens), use the steps outlined in the Control4 System User
Guide.

Suggested test items include:
e Play an album
e Add an album or track to the Now Playing queue
e Play a playlist created in Composer
o Create a playlist at a Navigator (such as one of the Touch Screens)
e Play multiple streams of music (play different music in different rooms)
e Play a movie on the Television

4.7 Setting Up Media for Television Stations

Use the Control4® Composer ME Media view to set up a broadcast television station and listings to
display on the Navigators.

4.7.1 Prerequisites

Ensure that your television is added and identified in the Control4 system. Your Control4 Dealer or
Installer can help you do that.

4.7.2 Procedure
To set up media for broadcast television channels:
1. Highlight UHF/VHF or another broadcast media type.
2. Click Search.
3. When the dialog appears, type your zip code in the box.
4

Click Search, and use the pull-down menu to select Local Broadcast Listings. The available
channels are populated according to the Search Results.

5. Check the boxes to select the desired channels that you want to appear on the Touch Screens,
On-Screen Navigators, and System Remote Control.

6. Click OK.

Copyright © 2010 Control4. All Rights Reserved.
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Zip: | 84020 Provider: ‘ NTSC [analog) Broadeast v ‘

Search Results
Hame Chaninel # D escription Getre Riating Audio Only
wDTRLP 18 False
wDTRLP 22 False
[0 KucLe 26 False
K59GS 46 False
= 43 False
KS2GL 50 False
O k4t 56 False
KUBKLP 58 False
KEEFN EE False

The selected stations populate in the UHF/VHF pane. You can edit the information as needed;
add a description, genre, etc.

7. (Optional) To edit a channel, select the channel, and click Edit. The following dialog appears.
8. Edit the information and click OK.
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9. Refresh the Navigators. The media can now be selected for viewing from the Navigators.
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Setting Up Media for Radio Stations

Use the Control4® Composer ME Media view to set up radio station listings to display on the

Navigators.

Prerequisites

Ensure that your devices are added and identified in the Control4 system. Your Control4 Dealer or

Installer can do that for you.

Procedure
To set up media for radio stations:

1. Under Broadcast, select the radio type: AM Radio, FM Radio, or XM Radio.
2. Click Search. When the dialog appears, type your zip code in the box.

3. Click Search again. Use the pull-down menu to select AM Broadcast Stations or FM Broadcast
Stations if applicable. The available stations are populated in the Search Results window.

4. Check the boxes to select the desired stations that you want to appear on the Touch Screens,
On-Screen Navigators, and System Remote Control for that radio type.

5. Click OK.
s x|
Zip: | 84020 Provider | &M Broadcast Stations v
Search Results
Hame Channel # Description Genre FRating Audio Only Lo
KALL 700 AM Morth Salt Lake City, UT Sports True
[0 kanN 1120 &M Row. UT Christian Corte. True
O KBJA 1640 &M Sandy, UT Spanish True
KCPw 10710 &M Taoele, UT Public Radia True
KDYL 1060 &M South Salt Lake, UT Mostalgia True
O kv 1450 &M Provo, UT Religious True
KFHZ 1320 &M Salt Lake City, UT Sports True
Fl KHON 1480 &M Spanish Fark, UT Religious True
KJos 1230 &AM Murray, UT Sports True
[0 kEaT 860 AM Salt Lake City, UT Country True
O KLLE 1510 &M WestJordan, UT Gospel Music True
Fl KLO 1430 &M Ogden, UT Talk True
.| EMRI 1550 &M Wiest Walley City, UT Religious True
OO kMTI E50 AM anti, UT Country True
O khak 540 A1 Delta, UT Talk True
Fl ENRS 670 AM Salt Lake City, UT Talk True
.| KOAL 750 AM Price, UT Sports True
O kowvo 960 A Provo, UT Sports True
[l KRRD TEO0 AM Centerville, UT Spanish True ¥

The selected stations display in the AM Radio pane.
6. (Optional) To edit a station, select the station, and then click Edit.

7. Edit the information, and then click OK.
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8. Refresh the Navigators.

9. Repeat Steps 1-5 for each radio broadcast (AM, FM, XM) you want to set up. Each must be set
up separately.

The media is now ready to view and use in the Navigators.

Using External Storage Devices

Access digital music from an external storage device attached to your Control4® system. External
storage devices include USB flash drives, USB external hard drives, or a PC'’s hard drive located on
the home network. Set up according to the external storage device and networked file storage as
described here.

Note: When you remove the external drive (network, USB, etc.), the music is no longer available. To
access the music again, return the external storage device, and refresh the Navigators.

Prerequisites

External storage devices must have media stored in unprotected MP3, or MAA/AAC, WMA, or FLAC
formats.

Procedures
To attach and scan external storage devices using a USB connection:
1. Power on the external storage device.

2. Use the documentation provided with your Controller to attach the external hard drive using the
USB port.

Copyright © 2010 Control4. All Rights Reserved.
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3. After connecting the external storage device, scan the music on the external device connected to
the Controller to make it available on the Control4 system. Highlight the Controller to which the
external device is connected.

4. Click Scan. When scanning, the media appears as it is located on the Controller.

Note: You can add media from the external storage device when connected to the Controller,
however, Control4 recommends that you connect your external drive directly to the PC where you
want to copy media.

To access and scan the network-shared storage devices:
1. Use the documentation provided with your operating system to create a shared network drive.

Example: Using Windows XP to make a local C:/ Drive directory available on the network, right-
click the folder and select Sharing and Security. Select the Share this folder button.

2. Configure the username, password, and workgroup (or domain) for the network file share. This
information varies between types; contact your system administrator if you need help with this
information.

3. Highlight the Network File Storage object.

4. Click Add or Scan.

4.10 Setting Up Playlists

Use the Control4® Composer ME Media view to set up a playlist to play songs and albums from your
Touch Screens, On-Screen Navigators, and System Remote Control.

4.10.1 Prerequisites

Ensure that the appropriate audio devices are added and identified on the Control4 system. Ensure
that you have scanned your media in the Digital Audio player. Your Control4 Dealer or Installer can
help you do this.

4.10.2 Procedure

Playlists are designed exclusively for streaming media in Digital Audio. If you subscribe to the
Rhapsody® Music Service, then Rhapsody playlists can be created using a Navigator. In OS 2.0,
playlists can include CDs/DVDs, broadcast channels or stations, but they are a separate playlist from
those in Rhapsody.

Note: To set up a Rhapsody subscription on behalf of the user or yourself, obtain a Rhapsody
account at http://www.control4.com/rhapsody, and then refer to the information found in the Control4
System User Guide.
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To create a playlist:

1.
2.

From the Media menu, select New Playlist.

A 'New' playlist appears. You can rename it now, or later you can right-click and select Rename
Playlist to change the name. Example: Change New to Frank’s Playlist.

Drag the list of songs to the playlist.

Have your Control4 Dealer or Installer add any albums or songs you want to the playlist. Or you
can create, edit and play your playlists using the Touch Screens or On-Screen Navigators.

To delete albums or songs from the playlist:

1.
2.

After you add the albums, select the playlist that contains the songs to delete.
Right-click on the songs you don't want in your playlist, and select Delete.

Tip: To remove multiple songs, press Shift, select the songs, and then right-click Delete.

4.11 Editing Media Information

Use the Control4® Composer ME Media view to edit CD or DVD media information. You can edit
media information also on the Touch Screens or On-Screen Navigators.

4.11.1 Prerequisites

Ensure that the appropriate media devices have been added and identified to the Control4 system.
Your Control4 Dealer or Installer can help you do this.

4.11.2 Procedure

To edit CD information:

1. Double-click the device on which you want to edit a CD, such as a CD Changer, Disc Changer,
Controller or Digital Audio.

2. Click the Edit button, or double-click the media under <Media> Title.

3. To edit and enter any changes, click the Album tab (for music), for example. Edit the information
in the boxes under Name, Artist, Label or Genre. Click the Tracks and Notes tabs to view and
edit Track Titles and Notes. Click Find Art File or Remove Art to change the cover art. When
finished, click OK.

4. Click one of the Search buttons next to the Name to search the database for similar entries.

5. To select a search result, select the album Title and double-click, or click Next. At the next
screen, view and edit the album information, including Name, Artist/Composer, Label, Genre,
Year, Art, and Notes.

6. Make your changes, and click Finished. To return to the previous screens, click Back.

Copyright © 2010 Control4. All Rights Reserved.
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To edit DVD information:

1.
2.
3.

7.

Select the Disc Changer or DVD, and then select a movie.
Click the Edit button, or double-click the title under Discs.

Click the Movie tab. Edit the Title, Director, Studio, Genre, Run Time, Release date and Rating as
desired.

Click the Cast and Synopsis tab. Click in the Cast and Synopsis boxes to make the desired
changes.

Click the Movie tab. Click Search to search the database for other DVDs.

Double-click the desired DVD, and edit the information as desired according to the previous
steps.

When you are finished, click Finished.

5. Other Composer ME Tasks

Use the Control4® Composer ME to perform other media-related tasks (see the sections below).

e “Clearing a Media List”

e “Exporting a Media List”

¢ ‘“Importing a Media List”

e “Updating Composer ME”

5.1 Clearing a Media List

Use the Control4® Composer ME Media menu to clean out information (metadata) about albums and
songs.

5.1.1 Prerequisites

Ensure that media has been added and identified to the Control4 system. Your Control4 Dealer or
Installer can help you do that.

5.1.2 Procedure

To clear a media list:

1.
2.

Select the device on which you want to clear the media information. Example: Digital Audio.
From the Media menu, select Clear Media List.

This removes the information including the title, Cover Art, and related information from the Media
Database.

Note: This option does not remove the media files.

Copyright © 2010 Control4. All Rights Reserved.
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Exporting a Media List

Use the Control4® Composer ME Media menu to export a media list from your Media Database to
your PC.

Prerequisites

Ensure that the device to export to and the media have been added and identified in the Control4
system. Your Control4 Dealer or Installer can help you with that.

Procedure

To export the Media List:

1. Select the device on which you want to export the Media List. Example: Digital Audio.
2. From the Media menu, select Export Media List.

This saves a copy of the file that contains all the title art and information from the Media Database to
your PC.

IMPORTANT: This option moves the media files.

Importing a Media List

Use the Control4® Composer ME Media menu to import a media list from your PC to the Media
Database.

Prerequisites

Ensure that the device to export to and the media have been added and identified to the Control4
system. Your Control4 Dealer or Installer can help you with that.

Procedure

To import the Media List from your PC to the Media Database:

1. Select the device on which you want to import the Media List. Example: Digital Audio.
2. From the Media menu, select Import Media List.

This saves a copy of the file that contains all the title art and information from your PC to the Media
Database.

IMPORTANT: This option does not move the media files.
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5.4 Updating Composer ME

Use Control4® Composer ME to update the software to a new version.

You can update three (3) ways:
1. Help menu

2. Windows Start menu

3. Run the Composer ME install

5.4.1 Prerequisites
Ensure that Composer ME has been installed on your PC.

5.4.2 Procedure
To update Composer ME:
1. Update according to these options.
e From the Help menu, select Check for Updates.

e From the Windows Start menu, select Start > All Programs > Control4 > Composer >
Update Composer.

e Run the installation.
2. Follow the on-screen instructions to complete the update.
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6. Glossary

4

4Sight: An Internet service that provides a connection to the Home-Automation System any time and
from any place worldwide.

A

AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and
encoding scheme for digital audio. Touts better sound quality.

AV: Audio Video

C

CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4
products.

Composer: The Control4 software used to design and define a Control4 Home-Automation System.

Composer Pro: Composer is used to set up and configure Control4 devices to communicate with
each other in a Home-Automation System.

connection: Binding or linking devices together in Composer so they can communicate with each
other.

contact: Contacts are generally used to monitor the status of something (door, window, water sensor,
etc.) and can be hooked up through a security panel or directly using a Control4 Controller or
Contact/Relay Extender. Contacts connected to a Control4 Controller or Contact/Relay Extender can
be configured either as NC (normally closed) or NO (normally open).

Control4 system: A Home-Automation System designed and developed by Control4.
Controller: The main device that makes Home Automation possible. There may be multiple

Controllers within a Control4 system. The Controller that runs Director is referred to as the Primary
Controller.

D

device: A component that requires a device driver; code that is used to allow the Control4 system to
work with that device.

device driver: Every device in the Control4 system needs a corresponding device driver to control
the device.

Digital Audio Player: Provides digital audio streaming capabilities from a Controller with hard disk
space for music and movies.

Director: Each Control4 Controller (such as a Home Controller HC-500) ships with pre-installed
Director software (Linux based) embedded in the device. The Director communicates with Control4
products and third-party products to enable Home Automation and interaction of individual devices.
Director runs the Control4 devices. Composer Pro is the software used to connect to and program a
system Director that resides on a Controller.

DVD: (Digital Versatile Disc) — A media format for video and data storage.
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E

Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star
network topology that allows multiple points to communicate to a single point. The Speaker Point®
and Mini Touch Screens use Ethernet to communicate to the Control4 Controller.

F
file format: A format used by applications to store/read files.

FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio
codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in
quality.

H

home network: A network installed in the customer’s home that provides an Ethernet or wireless
connection so that Control4 devices can communicate with each other.

Home-Automation System: The Control4 system: a line of Home Automation products that
communicate with each other over Ethernet, WiFi, or ZigBee for a total Home Automation experience.

L

LCD: (Lighted Crystal Display) - A display used with some Control4 interfaces.

LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen.
List Navigator: A System Remote Control device uses a Navigator that lists the options.

M

Media Database: Media information is stored in the Media Database, which will permit users to view
the media from the Navigators.

metadata: The information that describes the media: title, cover art, artist, song or movie, genre, etc.
MP3: A music format that makes streaming audio available.

N

Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc.
Navigator is software that the customer interacts with using a Universal Remote Control, On-Screen
Navigator, Touch Screen, or LCD Screen.

network-attached storage: A hard drive or network share drive that can be attached to the Control4
system and used to retrieve and play music and movies in the system.

o

On-Screen Device: Allows you to select the controller (Media Controller or Home Theater Controller)
in the room that controls the source for the on-screen display.

P

playlist: A list of songs compiled in a list. The list can be compiled by songwriter, alboum, song type, or
any combination.

programming: A machine-readable artificial language used to express computations that can be
performed by a device.
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project tree: A tree view in Composer where the project is layered by the larger branches (Home,
Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

R

Remote Director: Connects you to the home network while working in Composer from a remote
location.

S
scan: An electronic read of media for replay on Control4 devices.

switch: An extension of a router that adds more Ethernet ports to support additional devices or clients
on the local network.

System Remote Control: A Control4 System Remote Control is a universal solution that replaces
System Remote Control devices from other manufacturers, and includes programmable buttons. This
System Remote Control can access on-screen (Graphical) Navigators.

T

Touch Screen: A Touch Screen is a Home-Automation System Navigator that controls the home’s
lighting, music, videos, and other devices on the Home-Automation System.

U

USB: Universal Serial Bus) - A format used with USB sticks that plug in to a USB port on Control4
devices.

Y,
Virtual Connection: A term used in Composer Pro to indicate a connection outside the network.

Virtual Director: A connection to a virtual Controller only (a PC is the Director host rather than the
Controller). Projects created or edited here are benign until the saved project is loaded onto a
Controller.

W

WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices
“connect” to each other by transmitting and receiving signals on a specific frequency of the radio band
using a wireless access point. This technology uses the star network topology. WiFi uses high
bandwidth 802.11.

WMA: (Windows Media Audio) — Audio data compression technology developed at Microsoft; an
audio file format that competes with MP3.

z

ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer
messages from one device to another. Unlike a star network topology where devices can only send
messages to each other by sending them first to a single central device (which then delivers the
message to the recipient device), a mesh network topology allows the devices to forward messages
from one device to another, thereby extending the effective range of the network. Uses low bandwidth
802.15.4. 250 devices are allowed per controller but Control4 recommends 125.
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ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: allowing
more interoperability with other Control4 devices, support for home automation profiles, and improves
the scalability of multiple ZigBee access points.
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7. Index
4Store, 6 DVD, edit information, 31
AAC, 12 Edit metadata, 19
AAC format, 7 Exit Composer, 11, 15
Add Director, 13 Export Media List, 16
Add new CD, 20 Export Playlists, 16
Add new DVD, 20 File extension, add, 24
Album tab, 30 File menu, 15
AM radio, add, 27 File tags, 16
AM/FM/XM, 15 Find cover art, 30
AMG, 7 FLAC, 12
AMG lookup, 14 Flash interface, 6
Audio products, and ZigBee Pro, 7 FM radio stations, add, 27
Broadcast media, scan, 14 GNU, 2
Broadcast television selection, 25 Gracenote, 2
Cable TV, 15 Gracenote lookup service, 14
CD, 14 Gracenote online media lookup service, 7
CD Changer, scan media, 20 Hard disk requirements, 8
CD Changer, set up media, 18 Hardware not supported, 7
CD, add new, 19, 22 Hardware, and ZigBee Pro, 8
CD, edit information, 30 HDD, 14
Clear Media List, 16 Help menu, 15
Composer ME interface, 10 Import DVD List from File, 16
Composer ME, get started, 8 Import Media List, 16
Composer ME, update, 33 Import Playlists, 16
Composer, close, 11 Installation, 9
Composer, refresh Navigators, 11 10 Extender, 6
Connect to Director, 13, 15 iTunes, 7
Contact Information, 2 Legal Notice, 2
Copyright, 2 Local Broadcast Listings, 25
Cover Art, find, 30 Media Auto-Scan, 23
Cover Art, not found, 23 Media Controller limitations, 14
Create playlist, 30 Media database, 14
Delete media, 19 Media Database, scanning and adding to, 18
Delete Playlist, 16 Media file tags, 16
Delete songs from playlist, 30 Media list, clear, 31
Digital Audio, 14 Media list, export, 32
Digital Audio player, 29 Media list, import, 32
Direct TV, 15 Media menu, 15
Director, startup, 10 Media Monkey, 7
Directors dialog, 13 Media pane, 19
Disc Changer, 14 Media Player, 6, 23
Disc Changer pane, 20 Media Player, and NAS, 23
Disc Changer, set up media, 18 Media Player, scanning files, 23
Disclaimer, 2 Media scanning, status messages, 24
Disconnect from Director, 15 Media view, 13
Discs pane, 20 Media, remove, 25
Dish Network, 15 Memory requirements, 8
DVD, 14 Menu options, 15
DVD, add new, 19, 20 Movie tab, 31
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MP3, 12
MPEG, 2
MR3, 7
Music, add new, 22
Network file storage, 14
Network requirements, 8
Network share, access, 29
New media, 6
New Playlist, 16
Playlist, create new, 30
Playlist, delete songs, 30
Processor requirements, 8
Purpose of document, 6
Radio stations, add, 27
Refresh Composer ME, 11
Refresh Director list, 13
Refresh Navigators, 15
Refresh screen, 15
Related Documents, 6
Remove media, 25
Rename Playlist, 16
Requirements, 8
Rhapsody, 29
Scan media, 13, 19
Scan Now, 25
Scanning

iTunes, 24
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Schedule, 24
USB drive, 24

Windows Media Player, 24

Search dialog, 23

Search Results window, 23
Software not supported, 7
Software requirements, 8

Sony Disc Changer, auto-scan, 23

Start Composer ME, 9
Stop Scan, 25

Stored media, scan, 14
Test media, 25
UHF/VHF, 15, 25
UHF/VHF pane, 26

Unprotected format, media storage devices, 28

USB drive

scan, 24

using, 28
USB port, 28
Video requirements, 8
What's new, 6
Windows 7, 8
Windows Media Player, 7
Windows Vista, 8
Windows XP, 8
WMA, 12
WMA format, 7
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